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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
No part of this document may be reproduced in any form or by any means, electronic or 
mechanical, including photocopying, without express written permission of Schneider Electric.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2017 Schneider Electric. All Rights Reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000001659 06/2017 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book
At a Glance

Document Scope
This document describes the graphical user interface of SoMachine Central and the functions it 
provides.
For further information, refer to the separate documents provided in the SoMachine online help.

Validity Note
This document has been updated for the release of SoMachine V4.3.

Related Documents

You can download these technical publications and other technical information from our website 
at http://www.schneider-electric.com/en/download

Title of Documentation Reference Number
SoMachine Programming Guide EIO0000000067 (ENG);

EIO0000000069 (FRE);
EIO0000000068 (GER);
EIO0000000071 (SPA);
EIO0000000070 (ITA);
EIO0000000072 (CHS)

SoMachine Compatibility and Migration User Guide EIO0000001684 (ENG); 
EIO0000001685 (FRE); 
EIO0000001686 (GER); 
EIO0000001688 (SPA); 
EIO0000001687 (ITA); 
EIO0000001689 (CHS)
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Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
8 EIO0000001659 06/2017



Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

Standard Description
EN 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2008 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
EN 1088:2008
ISO 14119:2013

Safety of machinery - Interlocking devices associated with guards - Principles 
for design and selection

ISO 13850:2006 Safety of machinery - Emergency stop - Principles for design
EN/IEC 62061:2005 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2008 Digital data communication for measurement and control: Functional safety 
field buses.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive
EIO0000001659 06/2017 9



In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems
10 EIO0000001659 06/2017



SoMachine Central
SoMachine Central Introduction
EIO0000001659 06/2017
SoMachine Central Introduction

Chapter 1
SoMachine Central Introduction

Overview

Role of SoMachine Central
Starting SoMachine by double-clicking the respective icon on your desktop, launches SoMachine 
Central.
SoMachine Central is the main interface for:
 administration of projects
 launching the different tools provided by SoMachine Vx.y
 managing the workflow of a project
 managing the versions of a project
 offering system/project functions

Administration of Projects
 Open/close projects
 Create projects
 Save project / save project as
 Import/export of SoMachine Basic projects
 Import/export of Vijeo-Designer projects
 Upload/download projects
 Print project
 Open archives
 Administrate project properties/options
 Provide project statistics
NOTE: Most File menu entries are only available in SoMachine Central and deactivated in other 
tools like SoMachine Logic Builder and Vijeo-Designer.

Launching Tools Provided by SoMachine
The following tools can be launched from SoMachine Central:
 SoMachine Logic Builder
 Vijeo-Designer
 SoMachine Configuration Manager
 SoMachine Basic
 Further maintenance tools (for example Controller Assistant)
EIO0000001659 06/2017 11



SoMachine Central Introduction
Managing the Workflow of a Project
Project workflow steps:
 Configuration

Add, remove, and configure devices and communication.
 Application Design
 Controller

Program one or multiple controllers.
 HMI

Program and design your HMI application.
 Multiple Download

Download your project to the devices.
 Maintenance

Maintain your project with a set of tools.

Managing the Versions of a Project
 Create new versions of a project
 Select and restore a previous version of a project
 Display information on the available versions

Offering System/Project Functions
 SoMachine Logic Builder Options
12 EIO0000001659 06/2017



SoMachine Central
User Interface
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Chapter 2
User Interface

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
2.1 General Description of the SoMachine Central User Interface 14
2.2 General Description of the SoMachine Central Frame Window 18
EIO0000001659 06/2017 13



User Interface
General Description of the SoMachine Central User Interface

Section 2.1
General Description of the SoMachine Central User Interface

What Is in This Section?
This section contains the following topics:

Topic Page
SoMachine Central User Interface 15
User Interface Color Code 17
14 EIO0000001659 06/2017



User Interface
SoMachine Central User Interface

Frame Window
SoMachine Central provides a frame window with the following elements: 
 Toolbar (see page 20)
 Tools Access (see page 26) bar
 Help Center (see page 27)
The frame window offers functions which are needed frequently.

Main Screens
Moreover, SoMachine Central provides 4 main screens which guide you through the project 
workflow and allow interaction with the workflow.
 Get started (see page 29) screen
 Workflow (see page 45) screen
 Versions (see page 47) screen
 Properties (see page 51) screen

Taskbar
The Windows taskbar is displayed at the bottom of your Windows screen.
The taskbar entries allow you to switch to other opened tools.
The appearance of the SoMachine entries added to the taskbar depends on your Windows 
operating system.
EIO0000001659 06/2017 15



User Interface
Elements of the User Interface

1 Frame window
2 Main screen
3 Taskbar
16 EIO0000001659 06/2017



User Interface
User Interface Color Code

Overview
You can launch several instances of SoMachine Central.
The active instance of SoMachine Central and the tools launched by this instance are displayed in 
the foreground.
A color code illustrates which windows belong to the same instance.

Color Code
The color code is applied to the title bar and frame of the window.

Default Color Description
Green window of the active instance with focus
Shaded green window of the active instance without focus
Blue window of an inactive instance
You can customize the colors.
EIO0000001659 06/2017 17



User Interface
General Description of the SoMachine Central Frame Window

Section 2.2
General Description of the SoMachine Central Frame Window

What Is in This Section?
This section contains the following topics:

Topic Page
SoMachine Central Frame Window 19
Toolbar 20
Overlay Bar 21
System Options 22
Main Menu 25
Tools Access Bar 26
Help Center 27
18 EIO0000001659 06/2017



User Interface
SoMachine Central Frame Window

Overview
SoMachine Central provides a frame window with the elements listed below.
The frame window offers functions which are needed frequently.

Elements of the Frame Window

Element Description
1 Toolbar (see page 20)
2 Tools Access Bar (see page 26)
3 Help Center (see page 27)
EIO0000001659 06/2017 19



User Interface
Toolbar

Overview
The toolbar is part of the SoMachine Central frame window.
Each icon of the toolbar displays a tool tip when the mouse pointer is moved on the respective icon 
without clicking.

Elements of the Toolbar

Icon Description
1 Open the main menu (see page 25).
2 Create a new project.
3 Open an existing project.
4 Save the project, currently having the focus.
5 Save the project, currently having the focus, under a new name.
6 Open the System Options dialog (see page 22).
7 Connect to the controller (Connect dialog (see page 32)).
8 Open the help center (see page 27).
20 EIO0000001659 06/2017



User Interface
Overlay Bar

Overview
The overlay bar is provided for every project-related tool which has been launched by SoMachine 
Central. It offers functions of the SoMachine Central and it provides a fast switch to the SoMachine 
Central and between the tools.
The overlay bar is always accessible at the title bar of the tool, launched by SoMachine Central, 
currently having the focus. It can be moved along the title bar with the mouse.
Each icon of the overlay bar displays a tool tip when the mouse pointer is moved on the respective 
icon without clicking.

Elements of the Overlay Bar

Element Description
1 SoMachine Central icon

 Left-click to switch back to SoMachine Central.
 Move the mouse pointer on the icon without clicking to expand the overlay bar (System 

Options, Quick Toolswitch).
Each icon of the overlay bar displays a tool tip when the mouse pointer is moved on the 
respective icon without clicking.

2 Save the project, currently having the focus.
3 Save the project, currently having the focus, under a new name.
4 Open the help center (see page 27).
5 Create a new project.
6 Open the System Options dialog (see page 22).

Using this dialog you can edit the following options:
 Project Versioning
 Repository Management
 Logic Builder Options
 General Options
 Preferred directory for open/save projects

7 Quick Toolswitch
Click the arrow at the right to launch or to switch to the offered tools (for example Vijeo-
Designer).
EIO0000001659 06/2017 21



User Interface
System Options

Overview
You can open the System Options dialog from:
 the toolbar (see page 20)
 the overlay bar (see page 21)
 the versions screen (see page 47)

System Options Dialog Box
The system options are provided by 3 tabs:
 General Options
 Project Versioning
 Maintenance Tools
 Expert Mode
22 EIO0000001659 06/2017



User Interface
General Options Tab

Element Description
Preferred directory... Click the ... button to browse for the preferred directory for opening/saving 

projects.
Logic Builder Options button Open the Options dialog box of the SoMachine Logic Builder.
Project Assistant Settings Enter:

 Default Controller Name
 Default POU Name

Repository Management
Library Repository button Open the Library Repository dialog box of the SoMachine Logic Builder.
Device Repository button Open the Device Repository dialog box of the SoMachine Logic Builder.
Template Repository button Open the Template Repository dialog box of the SoMachine Logic Builder.
DTM Repository button Open the DTM Repository dialog box of the SoMachine Logic Builder.
Color Management Select the colors for:

 Inactive Frame
 Active Frame
 Inactive border
 Active border

License Management Click the Registration Wizard button to start the SoMachine Registration 
Wizard that guides you through the registration process for the SoMachine 
software.
EIO0000001659 06/2017 23



User Interface
Project Versioning Tab

Maintenance Tools Tab

Expert Mode Tab

Element Description
Automatic generation of 
project version

Use the ON/OFF button to switch the automatic creation of versions on/off.
A button with the same function is also available in the Versions screen.

Versioning mode Select one of the 2 modes:
 Time interval

Interval is the next value to be set.
 On save

On each save, a new project version is created.
Interval Defines the time pattern for automatic project saving (30 minutes to 

24 hours).
Each time the project is automatically saved, a new project version is 
created.

Keep versions for the last xx 
Days/Months
(xx represents the number of 
days/months.)

Defines the period for how long the project versions are stored 
(1...31 days/1...12 months).
Click the Days/Months button to switch between days and months.
Versions exceeding the defined period are deleted.
But the following versions are categorically kept:
 latest version per day
 locked versions (see page 48)

Increase version number on 
versioning

Activate this check box to increase the version number of the project each 
time a new version is created.

Directory for project versioning Click the ... button to open a Windows Explorer and to browse for a directory 
to store the project versions.

Element Description
Add external maintenance tool 
button

Opens a Windows Explorer that allows you to browse for a maintenance tool 
to be added (*.exe file).

Name column Names of the added external maintenance tools.
Path column Paths of the added external maintenance tools.
Remove column Click the bin icon in the row of the tool to be removed.

Element Description
Enable Expert Mode check box Enable this check box to start the tool selected from the list below as soon 

as an existing project is opened.
24 EIO0000001659 06/2017



User Interface
Main Menu

Overview
To open the Main Menu, click the icon in the SoMachine Central toolbar (see page 20).

The menu provides the following functions:
 Open the SoMachine Logic Builder.
 Open the Vijeo-Designer.
 Close Project
 Save Project as…
 Save Project as Compiled Library
 Save Project as Template…
 Save Project And Install Into Library Repository
 Save Archive…

 Convert... (see SoMachine, Programming Guide)
 Convert Twido Project...
 Convert SoMachine Basic Project...

 Import…
 Import Vijeo Designer Project...
 Import SoMachine Basic Project...

 Export…
 Export Vijeo Designer Project...
 Export SoMachine Basic Project...

 Print… (define the content of the documentation to be printed)
 Page Setup
 About
 Exit
EIO0000001659 06/2017 25



User Interface
Tools Access Bar

Overview
The tools access bar is displayed at the top of SoMachine Central.
It allows you to switch to other tools integrated to SoMachine.
Each icon of the tools access bar displays a tool tip when the mouse pointer is moved on the 
respective icon without clicking.

Elements of the Tools Access Bar

Button Description
Logic Builder Switch to the SoMachine Logic Builder in configuration mode.
Vijeo-Designer Switch to the Vijeo-Designer.
SoMachine Basic Switch to the SoMachine Basic.
Maintenance Select a maintenance tool to switch to (for example controller assistant, 

OPC configuration, and so on).

NOTE: The Diagnostic tool is only to be used with the Modicon LMC078 
Motion Controller.

Tools Select a tool to be launched.
The list of offered tools can be enhanced by dragging-and-dropping the 
respective tool to the Tools button.
Alternatively it is possible to administrate the list of tools in the system 
options.
26 EIO0000001659 06/2017



User Interface
Help Center

Overview
You can open the Help Center with the Help Center button at the top right of the SoMachine Central 
or with the ? button of the toolbar (see page 20) or of the overlay bar (see page 21).
The Help Center provides the following help topics:
 General Help
 Global Help (Programming guides, and so on)
 Central Introduction
 System User Guides
 Migration and Compatibility

 Learning Center
 Training Manual
 E-Learning
 Videos
 Examples (Example projects with corresponding documentation)

 Release information
 Readme
 Release Notes
 EULA

 Support
 Contact Support
EIO0000001659 06/2017 27



User Interface
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Chapter 3
Get Started Screen

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
3.1 Get Started Screen - General 30
3.2 Connect Dialog 32
3.3 New Project Dialog 34
3.4 Open Project Dialog 43
EIO0000001659 06/2017 29



Get Started Screen
Get Started Screen - General

Section 3.1
Get Started Screen - General

Get Started Screen

Overview
If you launch SoMachine Central, the Get started screen is displayed.
This screen provides the following project functions:
 Recent Projects
 Connect Controller
 New Project
 Open project
 List of recently opened projects
Moreover it provides:
 the latest Schneider Electric News.

Elements of the Get Started Screen
30 EIO0000001659 06/2017



Get Started Screen
Element Description
Navigation path For backward navigation, click an element of the navigation path displayed at 

the top of the Get started screen.
License status (at the top 
right)

Information about your Trial license (days until trial period expires)

Navigation area on the left-hand side of the Get started screen
Recent Projects button Return to the list of recently opened projects.
Connect Controller button  Open a project based on a connected controller.

 Create a new project based on a connected controller.
 Create a new project based on a template.
 Upload a project from a connected controller.
 Download a project to a connected controller.
 Use maintenance tools on the connected controller.

Refer to Connect (see page 32) dialog.
New Project button Create

 a project using an assistant.
 a project from a project template.
 an empty project.
 a new library.

Open Project button  Browse and open a project, library, or archive.
 Open and automatically convert a SoMachine Basic project or Twido project 

to a SoMachine project. Refer to the open project dialog (see page 43).
News area
News Displays the latest Schneider Electric news.
Recent projects area
Recent Projects list Displays a list of recently opened projects/libraries with Name, Last change and 

Directory.
Select a list entry to display project details in the information area beside the 
list:
 Created (Date)
 Title
 Author
 Company
 Last change
 Version (see page 36)
 user-defined image

Open Project button Open a project selected in the Recent Projects list.
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Section 3.2
Connect Dialog

Connect Dialog

Connect Controller

Also refer to Controller Selection (see SoMachine Motion, Programming Guide).

Open Project File
This option allows you to open a project file. If available in the preferred directory (set in the system 
options), the project of the connected controller will be opened. If the project of the connected 
controller is not available or if any other project should be opened, it is possible to open a File Open 
dialog box to select a project.

Create New Project
This option allows you to create a new project. Using this function creates a project which contains 
a controller of the same type as the connected controller.

Step Action Result/Comment
1 Click the Connect Controller button. The Select Controller dialog box is displayed.
2 The Ethernet network and the USB ports are 

scanned for available controllers.
The displayed list of controllers contains those 
controllers in the network that have sent a 
response to the request of SoMachine.

3 Select a controller in the list and click the 
Select button.

The Options dialog box is displayed.

4 Select one of the options:
 Open project file (Browse)
 Create new project
 Create project with template
 Upload project from controller
 Download project to controller
 Use maintenance tools

After selecting the option Upload project from 
controller you will be asked for a folder, where 
the project extracted out of the archive will be 
stored. In addition, you will be asked Do you want 
to open the project which has been extracted 
from the project archive? Selecting No offers the 
possibility to manually open the uploaded project 
later from the folder configured previously.

5 Click the Continue button. The selected option is executed.
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Create Project with Template
This option is available if a M241 device with solution cartridge is connected.
This option allows you to create a new project by using a project template. The project template to 
be used can be selected from a list of templates. 
The list of templates only offers templates which match the detected cartridge.

Upload Project from Controller
This option allows you to upload the project provided by the connected controller.

Download Current Project to the Controller
This option is available if a project is opened.
This option allows you to initiate a source download of the opened project to the connected 
controller.

Use Maintenance Tools
This option allows you to select and launch a maintenance tool.
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Section 3.3
New Project Dialog

What Is in This Section?
This section contains the following topics:

Topic Page
New Project Dialog - General 35
New Project Assistant 36
New Project Assistant - Templates 38
New Empty Project 40
New Library 42
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New Project Dialog - General

Overview
The first step in the workflow is to open or to create a project.
SoMachine Central offers several ways to create a new project:
 Using Assistant
 Template Based
 Empty Project
 New Library

Using Assistant
Select Using Assistant to open the New Project Assistant dialog box.
With this dialog box SoMachine guides you to start a new project. Based on the information you 
enter SoMachine proposes the best way for you to start your project.

Template Based
Select Template Based to open the New Project Assistant- Template dialog box.
This dialog box offers project templates starting with a machine type or a given recommended 
architecture. Templates allow a short project time by relying on a project that has already been 
successful.

Empty Project
Select Empty Project to open the New Empty Project dialog box.
With this dialog box, you can start a new project without any preconfiguration of devices or logic. 
Use of this option requires more knowledge of configuration and programming logic than when 
using the assistant or the templates.

New Library
Select New Library to open the New Library dialog box.
With this dialog box, you can create your own library. Libraries allow you to store parts of your 
application and machine know-how into a repository. Library objects can exist in different versions.
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New Project Assistant

Overview
The New Project Assistant helps you to create a project which already contains a controller and a 
POU already called by the main task.
Before creating the project, you can select which type of controller to use and which type of POU 
to create.

Elements of New Project Assistant
In the Get started screen, select New Project → Assistant to open the New Project Assistant dialog 
box.
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Element Description
Project Name Enter a name for your new project.
Start with Select the starting point for your project:

 Architecture
 The information area on the right side displays the available 

project templates sorted by name.
 Filters are displayed below Start with.

 Controller
 The information area on the right side displays the available 

controllers sorted and grouped by type.
 Filters are displayed below Start with.

 Machine type
 The information area on the right side displays the available 

project templates grouped by machine types (conveying, 
hoisting, and so on).

 Filters are displayed below Start with.

Filters 
(displayed if Architecture or 
Machine type is selected for Start 
with)

Select the options to filter the project templates displayed in the 
information area on the right side.

Filters
(displayed if Controller is selected 
for Start with)

Select the requirements for your controller:
 Field bus is needed
 Motion control is needed

Properties tab Open the Project Properties dialog box to enter additional project 
information:
 General
 Title
 Author
 Company
 Version
 Description

 Custom
 Project Image

The Version is specified using the following format: 
major.minor.build.revision. The components have to be integers 
greater or equal to 0. For example 4.0.1.0.
 major and minor are required
 build and revision are optional
 build is required if revision is defined

Matching Template tab Open a pre-filtered list of project templates using the selected controller 
(New Project Assistant - Templates dialog box (see page 38)).

Create Project button Create your new project.
After project creation, the Workflow screen (see page 45) is displayed.
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New Project Assistant - Templates

Overview
The New Project Assistant - Templates dialog helps you to create a project based on a given 
recommended architecture.
The list of project templates also contains TVDAs (tested validated documented architectures).
Templates allow a short project time by relying on a project that has already been successful.

Elements of New Project Assistant - Templates
In the Get started screen, select New Project → With Template to open the New Project Assistant 
- Templates dialog box.
38 EIO0000001659 06/2017



Get Started Screen
Element Description
Project Name Enter a name for your new project.
Project Templates Lists the available project templates grouped by machine types 

(conveying, hoisting, and so on).
The following information is displayed for the templates:
 Machine Type
 Name
 TVDA
 Description
 Details

i button
(displayed for each template in the 
Details column)

Open the Project template properties window, displaying detailed 
properties of the template and the respective values.

Filter Offers the following filter options:
 - No filter -
 Applications
 Architectures
 User Defined

Properties tab Open the Project Properties dialog box to enter additional project 
information:
 General
 Title
 Author
 Company
 Version (see page 36)
 Description

 Custom
 Project Image

Create Project button Create your new project.
After project creation, the Workflow screen (see page 45) is displayed.
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New Empty Project

Overview
The New Empty Project dialog helps you to create a new project without any preconfiguration of 
devices or logic.
Use of this option requires more knowledge of configuration and programming logic than when 
using the assistant or the templates.

Elements of New Empty Project
In the Get started screen, select New Project → Empty Project to open the New Empty Project 
dialog box.
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Element Description
Project Name Enter a name for your new project.
Properties tab Open the Project Properties dialog box to enter additional project 

information:
 General
 Title
 Author
 Company
 Version (see page 36)
 Description

 Custom
 Project Image

Create Project button Create your new project.
After project creation, the Workflow screen (see page 45) is displayed.
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New Library

Overview
The New Library dialog helps you to create your own library.
Libraries allow you to store parts of your application and machine know-how into a repository. 
Library objects can exist in different versions.

Elements of New Library
In the Get started screen, select New Project → New Library to open the New Library dialog box.

Element Description
Library Name Enter a name for your new library.
Properties tab Open the Project Properties dialog box to enter additional library 

information:
 General
 Title
 Author
 Company
 Version (see page 36)
 Description

 Custom
 Project Image

Create Project button Create your new project.
After project creation, the Workflow screen (see page 45) is displayed.
42 EIO0000001659 06/2017



Get Started Screen
Open Project Dialog

Section 3.4
Open Project Dialog

Open Project Dialog

Overview
In the Get started screen, select Open Project.
The Open Project dialog helps you to browse for an existing project, library, or archive.
To open the respective project/library/archive:
 Double-click the file name, or
 Click the Open button.
NOTE: If you open a SoMachine Basic project or a Twido project, it is automatically converted 
(see SoMachine, Programming Guide) to a SoMachine project. That is, the M221 or Twido device 
is replaced by an M241 device.
You can also convert projects and libraries created with CoDeSys V2 by selecting the 
corresponding project (*.pro) or library (*.lib) files in the Open Project dialog box. 
NOTE: 
Before you open the project or library to be converted, perform the following tasks:
 Install the .eds files available in the CoDeSys_V2 installation to SoMachine by using the Device 

Repository (see SoMachine Motion, Menu Commands, Online Help).
 Configure the conversion behavior in the Options → CoDeSys 2.3 converter dialog box of the 

SoMachine Logic Builder. It is accessible from SoMachine Central via the System Options → 
General Options dialog box (see page 23).

POUs, visualization, CAM, and CNC elements are converted. Several dialog boxes are displayed 
for each device and each library. They allow you to select a SoMachine device or library for 
replacement or to ignore them.
NOTE: The option Ignore the device. All application specific objects will not be available in the new 
project. in the Device Conversion dialog box and the option Ignore the library. The reference will 
not appear in the converted project. are selected by default. They have the effect that this dialog 
box will not be displayed again when the specific device or the specific library is converted. This 
applies to future SoMachine sessions. To see the dialog boxes again for future conversions, 
deactivate these options.
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To help assure a successful conversion:
 Verify that the new device supports the functions and communication ports that are required in 

your project.
 Avoid using direct addresses in your application.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Verify that any direct addresses used in your application (for example, %IB5) have been 

converted correctly after device conversion.
 Adapt the configurations manually and make sure that they provide the intended functionality 

for the converted devices.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Chapter 4
Workflow Screen

Workflow Screen - General

Overview
After generating a new project (see page 35) or opening an existing project (see page 43), the 
Workflow screen is displayed.
The screen shows a graphical representation of project workflow management.
 Configuration
 Application Design
 Controller
 HMI

 Multiple Download
 Maintenance
The Workflow screen allows you to interact with the workflow.
 Setup is done in the Get started screen (see page 30).
 For the other steps of project workflow, you can open dialogs or switch to the appropriate 

software tools (SoMachine Logic Builder, Vijeo-Designer, and so on).
To interact with the workflow, click the respective workflow steps represented as buttons.
If you select a workflow step, detailed information for this step is displayed at the bottom of the 
screen.
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Elements of the Workflow Screen

Element Description
Configuration Add, remove and/or configure devices and communication.

Click the Manage Devices button to open a dialog box for adding and 
removing devices.

Application Design  Controller
Program the controller (or multiple controllers) of your project.
Open the list of devices left beside the Start button.
Select a device and click the Start button.
The SoMachine Logic Builder is launched for working on the selected 
device.

 HMI
Program and design your HMI application.
Click the Start button to launch the Vijeo-Designer for working on the HMI 
devices.

Multiple Download Download your project to the devices.
Click the Download button to open a dialog box for selecting the respective 
devices.

NOTE: The HMI application is downloaded before the controller application, 
independent of the selected download sequence.

Maintenance Maintain your project.
Click this button to open a dialog box for launching the respective maintenance 
tools (for example controller assistant, OPC configuration, and so on).

Information area
(at the bottom of the screen)

Displays detailed information for the step selected in the workflow.
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Chapter 5
Versions Screen

Versions Screen - General

Overview
This screen displays a list of the available versions of your project and provides the following 
versioning functions:
 Lock/unlock a version
 Delete a version
 Restore a version
 Save a new version manually
 Configure the project versioning settings
For the project version selected in the list, the following properties are displayed at right-hand side:
 Title
 Author
 Company
 Version
 Image (user-defined image)
 Statistics
 Version Comment (read/write)
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Elements of the Versions Screen

Element Description
ON/OFF button Switch the automatic creation of versions on/off.
Version Files Lists the available versions of your project with the following information for 

each version:
 Timestamp
 File size
 Version Comment
 Lock/Unlock

Use the icon in this column to lock/unlock the respective version.
 Delete

Use the icon in this column to delete the respective version. A locked 
version cannot be deleted.
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Information area Select a list entry to display project version details in the information area 
beside the list:
 Title
 Author
 Company
 Version (see page 36)
 Image (user-defined image)
 Statistics
 Version Comment (read/write)

Restore button Restore the currently selected version in the list of versions.
After clicking the Restore button, you are asked whether the currently opened 
project should be saved as a new version.

Manual Version button Save a new version of the currently opened project.
Settings button Open the System Options dialog box to configure the Project Versioning 

settings (see page 24).
A brief description of the currently used settings is displayed left beside the 
Settings button.

Element Description
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Chapter 6
Properties Screen

Properties Screen - General

Overview
This screen displays the following properties of your project (read-only):
 Filename
 File path
 Last changed
 Statistics
Moreover it helps you to edit and save additional information for your projects (read/write):
 Title
 Author
 Company
 Version
 Comment
 Image (user-defined image)
 Custom Information
 Attachments
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Elements of the Properties Screen

Element Description
Properties (read-only)
Filename name of your project file
File path path, where your project file is stored
Last changed date and time of last change
Statistics statistical values for your project

For example number of POUs, devices, actions, and so on.
Properties (read/write)
Title Enter or edit the project title (default = project name).
Author Enter or edit information about the project author.
Company Enter or edit information about your company.
Version Enter or edit information about the project version (see page 36).
Comment Enter or edit comments on your project.
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Image Change or remove the user-defined image.
 Change button

Opens a Windows Explorer to browse for an image to be displayed for your 
project.

 Remove button
Removes the currently displayed image.

Custom Information Create additional fields to personalize your project.
 Name

Enter a name for the field to be added to the Project Information window.
 Information

Enter text to be displayed for the new information field.
 Type

Select Text, Number, Date, Boolean, or Version as type of information.
 Add button

Add a new line to the Custom Information table.
 Remove button

Delete the currently selected line in the Custom Information table.
Attachments Attach files to your project.

 Add button
Open a Windows Explorer to browse for a file to be attached for your project.
Select the file and confirm with OK.
The file name is displayed in the Name column.
Enter a Description for the attached file.

 View
Open the attached file.

 Save as
Open a Windows Explorer to save the attached file with a new name or in a new 
folder.

 Remove
Delete the currently selected attached file from your project

Project Settings button Opens the Project Settings dialog box (see SoMachine Motion, Menu Commands, 
Online Help) of the SoMachine Logic Builder.

Element Description
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Chapter 7
SoMachine Software Tools

Detecting and Launching Software Tools

Detecting Software Tools
SoMachine Central detects known software tools already installed on the PC.
These tools are available in the tools access bar (see page 26) and in the overlay bar 
(see page 21).
The SoMachine Logic Builder and the Vijeo-Designer are part of the SoMachine standard 
installation.
Other tools (for example maintenance tools) are optional and only available if installed on the PC.

Launching Software Tools
You can launch (or switch to) the different software tools
 by the tools access bar (see page 26)
 by the overlay bar (see page 21)
 by the taskbar (see page 15)
 in the Workflow screen (see page 46) 
 by Controller → Start
 by HMI → Start

 in the Workflow screen (see page 46) by Maintenance → Tools
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Chapter 8
Repository Management

Repository Management

Overview
SoMachine Central provides access to the repository management of the SoMachine Logic 
Builder.

Accessing the Repository Management
To access the repository management dialog boxes, proceed as follows:

Step Action
1  Click the System Options icon in the toolbar (see page 20) or

 Click the Settings button in the Versions screen (see page 48).
Result: The System Options dialog box opens.

2  Click the Library Repository button to open the Library Repository dialog box of the 
SoMachine Logic Builder.

 Click the Device Repository button to open the Device Repository dialog box of the 
SoMachine Logic Builder.

 Click the Template Repository button to open the Template Repository dialog box of the 
SoMachine Logic Builder.

 Click the DTM Repository button to open the DTM Repository dialog box of the SoMachine 
Logic Builder.
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Chapter 9
Working with Project Archives

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Saving a Project as Project Archive 60
Creating a Project from a Project Archive 64
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Saving a Project as Project Archive

Overview
Before you install a different version of SoMachine software, or when your project is finalized, 
create an archive of your project. The archive contains the files included and referenced in the 
project with settings and profiles.
Project archives provide the following advantages:
 You can extract the project archive to another computer with SoMachine installed. In this way, 

you can share your projects with others or run it on another computer.
 Creating an archive can help reduce compatibility concerns with later versions of SoMachine.
When you create an archive, you can save additional information that are not included in a *.project 
file:
 download information file
 third-party libraries
 EDS files
When you extract your archive in SoMachine, the files contained in your archive are automatically 
installed in your current SoMachine version.

Create a Project Archive on Your Computer
To create a project archive on your computer, proceed as follows:

Step Action Result/Comment
1 In the Main Menu of the SoMachine Central, 

execute the command Save Project as... → 
Save Archive....

The Project Archive dialog box opens.

2 Select the information to include in the 
archive by selecting / deselecting the check 
boxes of the different categories.

The individual categories are described below this 
table.

3 Click Save... The dialog box Save Project Archive opens.
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Categories of the Project Archive Dialog Box
The Project Archive dialog box allows you to select information from the project to include in the 
project archive. You can select an entire category or specific information within a category:

4 In the dialog box Save Project Archive, enter 
a File name, browse to the folder where you 
want to save the archive, and click the Save 
button.

The project archive file is created and saved at the 
specified location.

Step Action Result/Comment

Category Description
Download information files Select this option to include the compile information 

(the compileinfo file) to the archive of your project.
This allows you to log in to the controllers with the 
archived project without rebuilding the project.

FDT BulkData Select this option to include DTM information in the 
project archive.

Library profile Select the libraries from the list of libraries in the 
library profile used in the project.

Options Select the options to include in the archive, as they 
are defined in the Tools → Options dialog box. You 
can distinguish between local settings and user 
settings, but also all settings and project-specific 
settings.

Referenced devices Select the devices used in the project to include in the 
archive.
Select this category to help to preserve compatibility 
(see SoMachine Compatibility and Migration, User 
Guide).

Referenced libraries Select the libraries located in the Library Manager of 
your project to include in the archive.
Select this category to help to preserve compatibility 
(see SoMachine Compatibility and Migration, User 
Guide)

Visualization Profile Select the visualization profile in use to include in the 
archive of the project.
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Buttons of the Project Archive Dialog Box
The Project Archive dialog box contains the following buttons providing further functions:

Create an Archive on Your Controller
To create an archive on your controller allows having the complete project on your controller and 
is useful for maintenance tasks.
To achieve this, the following three main tasks has to be done.
1.) Configure the sources to be downloaded.
To define the elements to add to the archive, proceed as follows:

For further information, refer to the Project Settings - Source Download description 
(see SoMachine Motion, Menu Commands, Online Help).

Category Description
Additional files... Click this button to select individual files or folders to 

be included in the archive.
Comment Click this button to open an input field allowing you to 

enter a comment. This comment will be available 
when extracting the project archive.

Save Click this button to save the project archive.
Send Click this button to send the archive file via e-mail. 

The e-mail client installed on your computer is started 
and automatically opens a new email with the archive 
file in the attachment.

Cancel Click this button to close the Project Archive dialog 
box without creating a project archive.

Step Action
1 In the Properties screen (see page 51) of SoMachine Central, click the Project Settings button.
2 In the dialog box that appears, select Source Download → Additional Files.

The following options can be selected:
Option to connect with the uploaded project:
 Download information files

Options which are needed to connect with another SoMachine version:
 Download information files
 Library profile
 Referenced devices
 Referenced libraries
 Visualization profile
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2.) Download the project (sources) to the controller.
To archive your project on your controller, proceed as follows:

3.) Upload the project (sources) from the controller by selecting the option Upload project from 
controller in the Select Controller dialog box (see page 32). Open the project and connect to the 
controller.

Step Action Comment
1 In SoMachine Central connect to the controller 

(see SoMachine Motion, Programming Guide).
A dialog box is displayed.

2 Select the Download project to controller option. A dialog box is displayed.
3 Confirm with Continue. The project is archived and downloaded 

to the controller.
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Creating a Project from a Project Archive

Overview
To extract an archive file that has been created by executing the command Save Project as... → 
Save archive..., click the Open Project button in the Get Started screen. In the Open project dialog 
box, select the option Project Archive Files from the list right to the File name text box to display 
the files with the extension .projectarchive for selection.
When you have selected a project archive file in the Open project dialog box, click the Open button, 
then the Extract Project Archive dialog box is displayed. It allows you to configure the location to 
which the archive is extracted, and which files of the archive are extracted.
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Locations Area of the Extract Project Archive Dialog Box
In the Locations area of the Extract Project Archive dialog box, choose the folder into which the 
archive is extracted.
 Extract into the same folder where the archive file is located.
 Extract into the following folder:

Enter the path of the folder or click the ... button to browse for the folder.
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Click the Advanced... button to open the Advanced dialog box. It allows you to determine where to 
extract specific and additional files of the archive.
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Elements of the Advanced dialog box:

Click the OK button to return to the Extract Project Archive dialog box.

Contents Area of the Extract Project Archive Dialog Box
The Contents area of the Extract Project Archive dialog box shows the contents of the archive.
The Items tab shows the object categories in a tree structure. By default, all categories and thus 
all related files are selected for extraction. To exclude a category or specific objects of a category, 
deselect the respective node.
The Comment tab shows the comment that was entered when the project archive was created.

Extracting the Project Archive
To extract the project archive as configured in this dialog box, click the Extract button. 
If a file that needs to be extracted has the same name as an existing file in the target directory, a 
message is displayed. You are requested to decide whether you want to replace the local file or 
not. You can apply this choice to the following name conflicts by activating the option Apply to all 
items and files.

Element Description
Repositories

Install devices into Select an available device repository from the list.
The device files of the archive will be installed in the 
selected repositories.

Install libraries into Select an available library repository from the list.
The library files of the archive will be installed in the 
selected repositories.

Additional files By default, additional files are preset with the option Do not 
extract. 
You can select one or several file entries in the table and 
choose one of the options below. The remark in the table is 
adapted accordingly.

Extract into project folder The selected file is extracted to the same directory as the 
project files.

Extract into folder Specify the desired folder on your system or click the ... 
button to browse for the folder.

Do not extract Resets the selected file to the default mode.
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Chapter 10
Working with SoMachine Central

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
General 70
Setup 71
Configuration 72
Application Design 73
Multiple Download 74
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General

Overview
In general there are the following project workflow steps:
1. Setup (Get started screen (see page 71))

Select a controller and enter basic project information.
2. Configuration

Add, remove, and configure devices and communication.
3. Application Design (Workflow screen (see page 73))
 Controller

Program one or multiple controllers.
 HMI

Program and design your HMI application.
4. Multiple Download (Workflow screen (see page 74))

Download your project to the devices.

Ways to Create a New Project
There are various ways to start a new project with SoMachine Central:
 Using an assistant (see page 36)
 Template based (see page 38)
 Starting with an empty project (see page 40)
 Creating a new library (see page 42)

Launching SoMachine Central
To launch SoMachine Central:
 Double-click the SoMachine Central icon on your desktop or
 Click Start → Programs → Schneider Electric → SoMachine Software → Vx.y
The SoMachine Central Get started screen (see page 71) is displayed.
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Setup

Overview
The following example shows you how to set up your project with the New Project Assistant.

Get Started Screen
After launching SoMachine Central the Get started screen (see page 30) is displayed.

Step Action
1 In the Get started screen, select New Project → Assistant.

Result: The New Project Assistant dialog box (see page 36) opens.
2 In the General tab, enter a Project Name.
3 Optional step

Click the Details tab.
Result: The Detail Configuration dialog box opens.

4 Optional step
In the General tab, enter additional project information (title, author, and so on).
In the Project Image tab, you can add an image for your project.

5 Go back to the New Project Assistant → General tab.
6 For Start with select Controller.

Result: The information area at the right side displays the available controllers sorted and 
grouped by type.

7 Select your controller under Logic Controller.
8 Select the Program Language.
9 Click the Create Project button.

Result: The Workflow screen (see page 73) is displayed.
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Configuration

Overview
The following example shows you how to configure your controller after finishing the setup.

Procedure
After finishing the setup (see page 71), the Workflow screen (see page 45) is displayed.

Step Action
1 Click the save button in the toolbar (see page 20).
2 Click Configuration.
3 Click the Manage Devices button.

Result: A dialog box opens for adding and removing devices.
At the left side, you see the available devices. At the right side, you see the controller previously 
selected in the Get started screen.

4 Select your HMI and add it to your project by clicking the > button.
Result: The added HMI is displayed at the right side and the Vijeo-Designer is launched.

5 Close the dialog box.
6 Click the save button in the toolbar (see page 20).
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Application Design

Overview
The following example shows you how to work on your project after finishing setup and 
configuration.

Procedure
After finishing the configuration (see page 72), you can start your application design.

Step Action
1 Click Controller.
2 Open the list of devices left beside the Start button, select your controller, and click the Start 

button.
Result: The SoMachine Logic Builder is launched for working on your project.

NOTE: To switch back to SoMachine Central use the respective button in the overlay bar 
(see page 21).

3 Click HMI.
4 Click the Start button.

Result: The Vijeo-Designer is opened for working on your project.

NOTE: To switch back to SoMachine Central use the respective button in the overlay bar 
(see page 21).

5 Click the save button in the toolbar (see page 20).
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Multiple Download

Overview
One of the default options when you select Multiple Download, is the Start all applications after 
download or online change. This selected option restarts all download targets in the RUNNING 
state, provided their respective Run/Stop inputs are commanding the RUNNING state, but 
irrespective of their last controller state before the multiple download was initiated.
Deselect this option if you do not want all targeted controllers to restart in the RUNNING state.
In addition, before using the Multiple Download, test the changes to your application program in a 
virtual or non-production environment and confirm that the targeted controllers and attached 
equipment assume their expected conditions in the RUNNING state.

For further information, refer to Multiple Download (see SoMachine Motion, Menu Commands, 
Online Help).

Procedure
After finishing the application design (see page 73) and working on your project in SoMachine 
Logic Builder and Vijeo-Designer you can download your project to the devices.

WARNING
UNINTENDED EQUIPMENT OPERATION
Always verify that your application program will operate as expected for all targeted controllers 
and equipment before issuing the Multiple Download… command with the Start all applications 
after download or online change option selected.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Step Action
1 Click Multiple Download in the Workflow screen (see page 46). Click the Download button.

Result: A dialog box opens displaying the applications available for download (for example your 
controller application and your HMI application).

2 Select your applications to be downloaded.
3 Select the Online change options.
4 Select the Additional operations.
5 Confirm with OK.

Result: The selected applications are downloaded to the devices (for example to your controller 
and your HMI).
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Sequence of Downloads
Using the Move up/Move down button in the Multiple Download dialog box, you can adapt the 
sequence of downloads.
NOTE: The HMI application is always downloaded before any other controller application 
independent of the selected download sequence.
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Glossary
A
application

A program including configuration data, symbols, and documentation.

C
configuration

The arrangement and interconnection of hardware components within a system and the hardware 
and software parameters that determine the operating characteristics of the system.

control network
A network containing logic controllers, SCADA systems, PCs, HMI, switches, ... 
Two kinds of topologies are supported:
 flat: all modules and devices in this network belong to same subnet.
 2 levels: the network is split into an operation network and an inter-controller network.
These two networks can be physically independent, but are generally linked by a routing device.

controller
Automates industrial processes (also known as programmable logic controller or programmable 
controller).

D
DTM

(device type manager) Classified into 2 categories:
 Device DTMs connect to the field device configuration components.
 CommDTMs connect to the software communication components.
The DTM provides a unified structure for accessing device parameters and configuring, operating, 
and diagnosing the devices. DTMs can range from a simple graphical user interface for setting 
device parameters to a highly sophisticated application capable of performing complex real-time 
calculations for diagnosis and maintenance purposes.

E
expansion bus

An electronic communication bus between expansion I/O modules and a controller.
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H
HMI

(human machine interface) An operator interface (usually graphical) for human control over 
industrial equipment.

I
I/O

(input/output)

M
machine

Consists of several functions and/or equipment.

P
POU

(program organization unit) A variable declaration in source code and a corresponding instruction 
set. POUs facilitate the modular re-use of software programs, functions, and function blocks. Once 
declared, POUs are available to one another.

program
The component of an application that consists of compiled source code capable of being installed 
in the memory of a logic controller.

project file
A project file contains information about the developer and purpose of a project, the configuration 
of the targeted logic controller and associated expansion modules, the source code of a program, 
symbols, comments, and all other related information.

T
TVDA

(tested validated documented architectures) Control system proposals based on 
Schneider Electric components.TVDAs cover a wide range of machine types and consider 
machine performance requirements, installation constraints, and target costs. To optimize the 
implementation effort, each TVDA comes with a detailed component list, wiring diagrams, and 
commissioning guide, as well as controller and HMI applications to control components of the 
system. 
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Index
A
archives, 59

C
color code, 17
convert CoDeSys V2 project, 43

E
example, 70

F
frame window, 19

G
get started screen, 30

L
launching tools, 11

N
new project dialog, 35

O
open project dialog, 43

P
project administration, 11
project archives, 59, 60
project version management, 11
properties screen, 51
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R
repository management, 57

S
software tools

detecting and launching, 55
SoMachine Central

application design, 73
configuration, 72
multiple download, 74
setup, 71

system and project functions, 11

T
tutorial, 70

U
user interface, 15

V
versions screen, 47

W
workflow management, 11
workflow screen, 45
working with SoMachine Central

general, 70
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